ANT-20, ANT-20E
Advanced Network Tester

ATM Module
BN 3035/90.70

Software Version 7.20

Operating Manual
Please direct all enquiries to your local Wavetek Wandel Goltermann sales company. The addresses are given at the end of this handbook.

Copyrights
This product or parts of it are based upon
Recommendations and/or Standards of the
Standardization Sector of the International
Telecommunication Union - ITU-T and/or of the
European Telecommunications Standards Institute -
ETSI. These Recommendations and Standards are subject to copyrights of these organizations. Without written permission of the ITU-T and/or ETSI it is not permitted to copy ITU-T Recommendations or ETSI standards or parts thereof and/or make them available to third parties.

Wavetek Wandel Goltermann
Eningen GmbH & Co.
Mühleweg 5, 72800 Eningen u. A.
© 2000
Author: MDD/TD
Translator: John Nutley
Order no.: BN 3035/98.28
Edition: 12/00.07 (V 7.20)
Previous edition:
11/00.04 (V 7.1)
Subject to change without notice
Our normal guarantee and delivery terms apply
Printed in Germany
Contents

Introduction

1 Overview ................................................................. I-1

2 Applications ................................................................. I-2
  2.1 Complete ATM bit error rate test (ATM-BERT) ............... I-2
  2.2 Real-time performance analysis ................................. I-3
  2.3 ATM analyzers in the ANT-20 ................................. I-4

Operation

1 General instructions .................................................. O-1

2 ATM applications ...................................................... O-1
  2.1 Signal Structure window ........................................ O-3
  2.2 ATM Signal Structure window ................................. O-4
  2.3 ATM Traffic Analyzer window ................................. O-6
    2.3.1 Time Diagram .............................................. O-6
    2.3.2 Histogram ................................................ O-7
    2.3.3 User Channel Analysis .................................. O-7
    2.3.4 Cell Transfer Delay ..................................... O-8
    2.3.5 Printout and export of results ........................... O-10
  2.4 Anomaly/Defect Analyzer window ............................. O-11
  2.5 Anomaly/Defect Insertion window ............................ O-12
  2.6 ATM Background Generator window .......................... O-13
  2.7 Measurement interdependence ................................. O-15
    2.7.1 DS3 and DS3-PLCP mappings ............................ O-15
    2.7.2 Measurements with test cells .......................... O-15
Applications

1 Setting the ATM signal structure ........................................... A-1
  1.1 Test setup and description ................................................. A-1
  1.2 Application settings ....................................................... A-1

2 ATM bit error rate test (ATM-BERT) ........................................... A-5
  2.1 Test setup and description ................................................. A-5
  2.2 Switch configuration ........................................................ A-5
  2.3 Application selection on the ANT-20 ................................. A-5
  2.4 Measurement ................................................................. A-6

3 ATM latency test for ATM switches .......................................... A-9
  3.1 Test setup and description ................................................. A-9
  3.2 Switch configuration ........................................................ A-9
  3.3 Application selection on the ANT-20 ................................. A-9
  3.4 Measurement ................................................................. A-10

4 ATM latency test with background load
   (ATM background generator) ............................................... A-14
  4.1 Test setup and description ................................................. A-14
  4.2 Switch configuration ........................................................ A-14
  4.3 Application selection on the ANT-20 ................................. A-15
  4.4 Measurement ................................................................. A-15

5 Sensor test - loss of cell delineation (LCD) .............................. A-18
  5.1 Test setup and description ................................................. A-18
  5.2 Switch configuration ........................................................ A-18
  5.3 Application selection on the ANT-20 ................................. A-19
  5.4 Measurement ................................................................. A-19

6 Measuring the CLR with a variable cell rate (VBR traffic) ..... A-22
  6.1 Test setup and description ................................................. A-22
  6.2 Switch configuration ........................................................ A-22
  6.3 Application selection on the ANT-20 ................................. A-22
  6.4 Measurement ................................................................. A-23
Specifications

1 ATM generator .................................................. S-1
  1.1 Scrambling .................................................. S-1
  1.2 Error insertion (anomalies) ................................. S-1
  1.3 Alarm generation (defects) ................................. S-2
  1.4 Test channel ................................................. S-3
  1.5 Background load ............................................. S-4
  1.6 Fill cells ..................................................... S-4
  1.7 AAL-1 segmentation ......................................... S-4

2 ATM receiver ..................................................... S-5
  2.1 Descrambling .................................................. S-5
  2.2 Measurement modes. ....................................... S-5
     2.2.1 Error measurement (anomalies) ...................... S-5
     2.2.2 Alarm detection (defects) ............................ S-6
     2.2.3 ATM performance measurements ..................... S-6
     2.2.4 Payload channel analysis and load measurement ... S-7
     2.2.5 AAL-1 Reassembly ..................................... S-9
Notes:
Introduction

1 Overview

The ATM Options expand the applications of the **ANT-20 Advanced Network Tester** to cover use in ATM networks. The measurement methods and user interface have been specifically designed for applications involving user-network interfaces and network-network interfaces (UNI/NNI).

- These options are used for checking all of the important performance parameters of ATM networks and network elements.
- The versatile cell generator tests important policing and alarm functions.
- The ATM BERT function is used for testing ATM paths and channels.
- The assembly/reassembly function is used to determine the quality of service (QoS) in the "ATM Adaptation Layer" (AAL-1).
- The ATM alarm sensors of network elements can be tested.
- The ATM options also provide applications for the ATM “Circuit Emulation” service which is now commercially available.

The ATM options for the ANT-20 comprise the ATM basic module and additional frame structures and mappings. All of the ATM options can be integrated into the Mainframe and combined with other ANT-20 options such as the jitter or STM-16 modules.

The interfaces for the transmitter and/or receiver are configured with a single keystroke, independently if required. This allows measurements on half-channels on international gateways (SDH/SONET), network terminations (NT), terminal adapters (TA), ATM service MUX or cross connects (DXC) and medium adapters (ATM converters).

![Diagram](image)

Fig. I-1 The flexibility of the ANT-20 ATM functions allows it to be used on all interfaces
2 Applications

2.1 Complete ATM bit error rate test (ATM-BERT)

The bit error rate test is a basic method which is also used for testing network paths or the configurations of network elements quickly and simply in ATM networks.

The ANT-20 measures bit errors over one test cell channel.

- The bit error ratio in the ATM layer is determined by mapping a pseudo-random bit sequence into the cell payload (AAL-0).
- The bit error ratio in the AAL layer is determined by generating a pseudo-random bit sequence with the AAL-1 mapper (in preparation).

An error measurement for correctable and non-correctable header errors is made simultaneously with the bit error measurement in the cell payload. If this error measurement is made using cells with AAL-1 structures, the ANT-20 simultaneously checks the cell sequence integrity so that cell losses can also be determined.

Fig. I-2 ATM-BERT generator configuration
2.2 Real-time performance analysis

Network performance measurements based on the ITU-T recommendations I.356 and O.191 give information on the quality with which the various broadband services can be provided. Such measurements are a part of system acceptance, commissioning and monitoring of ATM networks.

A test cell channel to O.191 (Draft 4/95) is generated for the performance measurement. This ITU-T recommendation specifies measurement methods for determining the performance parameters. For example, the measurement algorithm and test cell format for measuring “Errored Cells”, “Cell Loss” or “Cell Delay” are specified. The analysis is in preparation.

Fig. I-3 Generator configuration for performance measurement
2.3 ATM analyzers in the ANT-20

The ATM options allow use of all of the analyzers which are available from the ANT-20 Application Manager.

To make measurements on signals with ATM structures, use the ATM-specific analyzers, i.e.:

- ATM Traffic Analyzer
- Anomaly/Defect Analyzer

Fig. I-4 Hierarchical overview of analyzers in the ANT-20
Operation

1 General instructions

The ATM Options are operated just like the ANT-20 Mainframe. Three new windows (virtual instruments) are available:

- “ATM Signal Structure” window
- “ATM Traffic Analyzer” window
- “Background Load Generator” window

Several of the windows (virtual instruments) included with the Mainframe include ATM features:

- “Signal Structure” window
- “Anomaly/Defect Analyzer” window
- “Anomaly/Defect Insertion” window

2 ATM applications

ATM applications are created or loaded from the Application Manager using the commands “New” and “Open …” in the “Application” menu.

An ATM application is configured using the “ATM Signal Structure” and “Signal Structure” virtual instruments (VI).

The parameters for the ATM layer are set in the “ATM Signal Structure” window, e.g.:

- Channel
- Path
- Load
- Profile
- PDU
- Test cell channel structure
The parameters for the physical layer are set in the “Signal Structure” window, e.g.:

- Interface
- Bit rate
- Offset
- ATM mapping

The block diagram below indicates the generators and analyzers used in an application:

![Fig. O-2 Generators and analyzers used in an application](image)

The traffic parameters for the test cell channel (foreground channel) are set in the “ATM Signal Structure” window. Additional ATM traffic can be generated using the background load generator.

The foreground channel and background load generator can be switched in or out as required.

The analyzers in the ANT-20 operate simultaneously.

Numerical statistics for important error events covering all layers are presented in the “Anomaly/Defect Analyzer” window. These include the ATM bit error rate (ATM-BERT), which is represented by “TSE” (Test Sequence Error).

The “ATM Traffic Analyzer” window displays typical traffic analyses for a selected channel in the ATM layer. It measures the load for the channel set in the “ATM Signal Structure” (Rx) window or the load histogram.
2.1 Signal Structure window

In order to use ATM signal structures, these must be set for the generator or the receiver of the ANT-20.
The appropriate interface, frame or hierarchy level and the ATM mapping need to be selected.

The “Multiplexing Structure …” command is found in the “Edit” menu. This command opens the “Signal Structure Editor - TX (RX)” window.
The ATM mapping for a specific bit rate is set in this window.
ATM mapping is activated as soon as you click on the “ATM” button in the “Signal Structure Editor - TX (RX)” window and confirm this by clicking on the “OK” button.

All settings which affect the ATM layer are described in the next section.
2.2 ATM Signal Structure window

The ATM Tx parameters are set in this window. You can also set the cell filter for the receive channel or select the measurement mode.

![ATM Signal Structure window](image)

The “ATM Structure ...” command in the “Edit” menu of the “Signal Structure” window opens the “ATM Structure” window. Select one of the four test channel structures from the “ATM SDU” section of this window:

- AAL0: ATM BERT, determination of bit error ratio in the ATM layer
- AAL1: 1) ATM BERT with AAL-1 SDU, determination of bit error ratio in the AAL layer
  2) Circuit emulation
- Testcell: ATM cell transfer performance measurements using test cells

You can select one of two measurement modes in the “Performance Measurement” section of the “ATM Structure” window if “Testcell” channel structure is selected:

- Cell Transfer Delay
- Error-related Performance

The results of the “Cell Delay Transfer” measurement will be displayed in the ATM Traffic Analyzer window, whereas “Error related Performance” results will be displayed in the Anomaly and Defect Analyzer window.
The “ATM Channel ...” command in the “Channel” menu is then used to open the “ATM Channel” window where you enter the VPI/VCI parameters for the generator and receiver.

![Fig. O-5 “ATM Channel” window](image)

To set the TX header values, the “ON” switch in the “Toolbar” of the “ATM Signal Structure” window must be set to off. The “ON” switches the test channel in or out. When switched out, the generator outputs (e.g.) empty or idle cells only.

Further Tx parameters affecting the signal structure or the traffic profile are set using the other menus in the “ATM Signal Structure” window.

One important characteristic is the load setting which you can change during the course of a measurement. This provides you with an extremely flexible test channel (Foreground Channel) which can be altered without interruptions.

A CLP filter is also available for mapping using concatenated containers for OC-12c or STM-4c. “CONCAT.” mapping must be pre-selected in the “Signal Structure” VI (see Fig. O-3) for this.

![Fig. O-6 “ATM Channel” window for OC-12c / STM-4c](image)
### 2.3 ATM Traffic Analyzer window

The “ANT-20 - ATM Traffic Analyzer” is designed for the following measuring tasks:

- Load measurements (Time Diagram)
- Channel loading measurements (Histogram)
- Channel efficiency measurements (User Channel Analysis)
- Cell delay measurements (Cell Transfer Delay)

The “ATM Traffic Analyzer” is used to investigate the cell stream received by the receiver. Various measurement modes are provided in the “View” menu for individual analysis of the cell stream. As well as the graphical display, the results can also be classified and displayed numerically.

#### 2.3.1 Time Diagram

The total load in all active ATM channels as well as the test channel is displayed versus time in the “Time Diagram” display (see Fig. O-7). The display also distinguishes between average and peak cell rates for the selected receive channel. The “Peak Cell Rate” function shows bursty traffic situations in the test channel. In accordance with ITU-T I.371, the minimum distance between cells in the test channel have been measured.

![Time Diagram](image_url)

**Fig. O-7** "ATM Traffic Analyzer" window, load vs. time diagram display
2.3.2 Histogram

The “Histogram” display (see Fig. O-8) allows you to determine the load profile of all active ATM channels and of the test channel and to make a direct record of the channel loading in the network. The load is measured at consecutive 100 ms intervals for this purpose. The number of intervals in which a load of 0, 1, 2 to 100 % is measured is counted and displayed in a histogram. The X axis shows the class index (Load = 0, 1, 2 to 100%). The Y axis shows the number of 100 ms intervals in which a load corresponding to the class index occurred.

The load can also be displayed in absolute terms, e.g. in Mbit/s (see Fig. O-8) instead of the relative load in %. The class width or display resolution is then approximately 1.5 Mbit/s. The load can also be displayed in cells/s.

Fig. O-8 “ATM Traffic Analyzer” window, channel load diagram display

2.3.3 User Channel Analysis

It is possible to make a user channel analysis within any specified measurement period in the “User Channel Analysis” display (see Fig. O-9). As well as the number of user cells, the diagram also indicates the number of cells for monitoring and management which occur, including OAM cells for information flows F4, F5.

Fig. O-9 “ATM Traffic Analyzer” window, user channel cell distribution display
2.3.4 Cell Transfer Delay

The “Cell Transfer Delay” diagram (see Fig. O-10) shows the statistical distribution of cell transfer delay times within a selectable measurement interval. The measurement interval (e.g. 1310 µs) is always divided into 128 classes. Test cells generally will be added, which occur within a class (e.g. 10 µs). The total amount of cells from one class will be displayed as one bar graph. The distribution of cell transfer delay times is thus shown against the X axis (bar graph sequence). The measurement interval can be increased stepwise by increasing the class width.

![Cell Transfer Delay Diagram](image)

Fig. O-10 “ATM Traffic Analyzer” window, cell transfer delay diagram display

Cell Delay Variation (CDV)

The “Cell Delay Variation” (CDV) can be determined from the “Cell Transfer Delay” display mode. The peak-to-peak CDV can be seen from the histogram; this corresponds to the 2-point cell delay variation as per ITU-T I.356. CDV evaluation provides the following results:

- Minimum cell delay
- Maximum cell delay
- Average cell delay
- 2-point cell delay variation (2-point CDV)

![Cell Delay Variation Diagram](image)

Fig. O-11 Definition of peak-to-peak CDV
Measurement range and resolution of cell delay measurements

To display the Cell Delay Variation of a device under test accurately, the Class Width should be as narrow as possible. This parameter can be set in the “Cell Transfer Delay Setup” window of the Traffic Analyzer (see Fig. O-12).

The resolution of the histogram is determined by the class width. The smaller the class width, the higher the resolution. If a small class width is chosen, however, it is possible that the measurement range for absolute delay may not be sufficient for path measurements (measurement range = class width x 128). To compensate for this and still allow a high resolution display, an offset value can be set that determines the starting point of the histogram. To illustrate how this works, some example figures are given below.

**Example: ATM Switch**

An ATM Switch is specified as having an absolute delay of 11 µs between the input and output ports. Since the expected measurement value is around 11 µs, the minimum class width setting of 0.16 µs will be suitable if the offset value is 0. The display range of the histogram window will then be from 0 to 20.5 µs.

If cell delays of more than 20.5 µs occur, this is indicated by an overflow message in the highest class.

It is therefore useful if the absolute cell delay is known or can be determined. If the magnitude of the delay is unknown, the absolute delay of the device under test can be determined empirically by varying the class width using the setup dialog (see Fig. O-12) of the Traffic Analyzer.

If the device under test has a similar delay to that of a typical ATM switch, it should be sufficient to set the class width to the minimum value in order to determine the absolute delay and at the same time achieve a high display resolution.

**Example: Path measurement**

Higher delay values can be expected when measuring a communications path. Delays of the order of 5 ms can be expected for a path linking two cities. To cover this range with an offset setting of 0 requires a class width setting of 81.92 µs.

To increase the resolution of the delay measurement, it is a good idea to use a suitable offset value. Setting the offset value to 4999 µs (to correspond with the expected 5 ms delay) will allow the measurement to be performed using the minimum class width setting of 0.16 µs. The measurement range will then be from 5000 µs to 5020.48 µs.

The histogram display for the above example is shown in the next figure.
2.3.5 Printout and export of results

The results from the ATM Traffic Analyzer can be printed out or exported using the “Print” menu. The menu contains the following commands:

Print ...

Prints a list of all results in the “ATM Traffic Analyzer” window that were recorded during a measurement. The printout may require several pages, depending on the number of ATM result values. Additional information about the measurement is printed out on the first page, i.e. start time, stop time and analyzer signal structure setting.

Only the ATM results for the selected display mode are printed out. If “Cell Transfer Delay” is selected, for example, then only the relevant delay time results will be printed out.

The print quality, number of copies and scope of the printout (“all” or “from page x to page y”) can be set in the print dialog window.

Printer Setup ...

The printer setup dialog is used for configuring the printer, setting the paper size and other parameters.

Information about how to install a printer is found in section 12 of the ANT-20/ANT-20E Mainframe Operating Manual.

Export ...

The export dialog is used for converting the results files so that they can be processed using other applications (e.g. spreadsheet programs) or linked into a database.

The result files are saved as CSV format files (comma separated value). Each value in the list of results is separated from the next by a specified character.

Only the ATM results for the selected display mode are exported. If “Cell Transfer Delay” is selected, for example, then only the relevant delay time results will be converted.
2.4 Anomaly/Defect Analyzer window

The “Anomaly/Defect Analyzer” window has been expanded to include ATM events, which enables to generate error and alarm situations

- in the physical layer,
- in the ATM layer (Quality of Service),
- in layers of higher order.

These include, for example, correctable and non-correctable header errors (HCOR, HUNC), AAL-1 error events and also the results of real-time performance analysis (CER, CLR, CMR).

![Fig. O-14](image-url)
2.5 Anomaly/Defect Insertion window

This window contains two ATM pages from which ATM events can be inserted.

Figure below left: This page allows insertion of anomalies.

Figure below right: This page allows insertion of “ATM Fault Management” defects (alarms). The defects refer to the test channel (Foreground Channel).

Fig. O-15 “Defect/Anomaly Insertion” window
2.6 ATM Background Generator window

The “ATM Background Generator” is an independent cell generator that can be used to define your own ATM traffic. The cell generator is designed for generating background traffic as it can be switched on or off independently of the test channel (“ATM Signal Structure” VI). The test channel has precedence over the background traffic.

ATM traffic comprises one or more cell sequences that are made up from user and empty cells. The following basic procedure is necessary to define the ATM traffic:

1. Define the cell sequences (user and empty cells)
2. Define the traffic (by selecting various cell sequences)

You can define new cell sequences under specific names using the “Sequence Editor”. To produce the required traffic, the sequences are selected as required from the list of available sequences and entered into the “Transmit List”. The sequences can be selected and arranged in any order to generate different traffic streams. Two examples are illustrated below:

- A cell sequence, “seq1”, comprising 2 user and 5 empty cells
- ATM traffic made up from the sequences seq2, seq3 and then seq1 twice.

![ATM Background Generator window](image)

Fig. O-16 “ATM Background Generator” window showing “traffic 2” ATM traffic, compare (see Fig. O-17)

ATM traffic comprises one or more cell sequences that are made up from user and empty cells. The following basic procedure is necessary to define the ATM traffic:

1. Define the cell sequences (user and empty cells)
2. Define the traffic (by selecting various cell sequences)

You can define new cell sequences under specific names using the “Sequence Editor”. To produce the required traffic, the sequences are selected as required from the list of available sequences and entered into the “Transmit List”. The sequences can be selected and arranged in any order to generate different traffic streams. Two examples are illustrated below:

- A cell sequence, “seq1”, comprising 2 user and 5 empty cells
- ATM traffic made up from the sequences seq2, seq3 and then seq1 twice.

![Cell sequence “seq1” used in ATM traffic](image)

Fig. O-17 The cell sequence “seq1” used in ATM traffic
**ATM Background Generator window for OC-12c / STM-4c**

Only with option BN 3035/90.92

If the signal structure is set to OC-12 or STM-4 concatenated in the “Signal Structure” VI, the background load generator provides a single channel (VPI/VCI).

![ATM Background Generator window for OC-12c / STM-4c](image)

**Fig. O-18** “ATM Background Generator” window for OC-12c / STM-4c

There are two traffic options for the background channel:

- **CBR**: ATM background traffic at a constant bit rate of 449.28 Mbit/s.
- **Fill**: Fills the cell stream with a background load up to a fixed bandwidth (in addition to the test channel of the “ATM Signal Structure” VI).
2.7 Measurement interdependence

2.7.1 DS3 and DS3-PLCP mappings

When receiving ATM cells mapped into DS3 and DS3-PLCP, both these parallel measurement modes must be selected before starting the measurement. A dialog window (shown in Fig. O-19, Page O-15) is included in the “ATM Traffic Analyzer” and “Anomaly/Defect Analyzer” virtual instruments for this purpose.

Three groups of active measurement modes can be preselected in the “Select measurements” option box; these are more precisely defined by the marked options in the “DS3”, “PLCP” and “ATM” fields.

- “Standard” group: Preselection of the most important measurement modes for the structure; (see Fig. O-19).
- “All ATM” group: Preselects all the measurement modes in the “ATM” field.
- “DS3 (+PLCP)” group: Preselects all the measurement modes in the “DS3” and “PLCP” fields (all ATM measurement modes are disabled).

Alarm detection is always active, regardless of the settings in this dialog box.

2.7.2 Measurements with test cells

The following display modes are inactive when measurements using test cells are made:

- **TSE** Bit error measurement using the Anomaly/Defect Analyzer (Test Sequence Error)
- **CLP** User channel analysis of cells with CLP = 1 using the Traffic Analyzer (Cell Loss Priority)
Notes:
Applications

1 Setting the ATM signal structure

1.1 Test setup and description

![ATM signal structure test setup](image)

Fig. A-1 ATM signal structure test setup

**Interfaces**

- electrical balanced Rx : [12] Tx : [13]
- optical 52, 155, 622 Mbit/s Rx : [17] Tx : [18]
- optical 2.5 Gbit/s Rx : [44] Tx : [47]

To perform an ATM measurement with the ANT-20, you must first select the corresponding signal structure. This section describes the step-by-step procedure for this with the aid of an example.

1.2 Application settings

**VIs required**

- Signal Structure
- ATM Signal Structure

1. Add the necessary VIs to the list of VIs used in the Application Manager. The Application Manager contains at least the following virtual instruments (see Fig. A-2).
2. For the following settings click on one of the buttons (minibar) to bring the desired window on top.

![Minibar (Application Manager) after selecting the VIs](image)

Fig. A-2 Minibar (Application Manager) after selecting the VIs
Example

ATM signal structure with STM-1 / VC-4 ATM mapping

Setting the physical layer (“Signal Structure” VI)

✓ The “Signal Structure” window is activated. The display area shows the current signal structure.

1. Select “Signal Structure...” from the “Edit” menu.
   – or –
   Click on the corresponding icon in the Application Manager.
   The “Signal Structure Editor” dialog opens (see Fig. A-3).

Fig. A-3  The “Edit Signal Structure” dialog (“Signal Structure” VI)

2. Set the required signal structure. Select the interface (SDH / PDH) and an appropriate ATM mapping.
3. Activate the ATM mapping by clicking the “ATM” button in the “Mapping” field.
4. Confirm your settings by clicking on the “OK” button.
   The display area shows the new signal structure.

Fig. A-4  Physical layer signal structure (“Signal Structure” VI)
Setting the ATM / AAL layers ("ATM Signal Structure" VI)

✓ The “ATM Signal Structure” window is activated. The display area shows the current ATM signal structure.

1. Select “ATM Signal Structure...” from the “Edit” menu
   – or –
   Click on the corresponding icon in the toolbar.
   The “ATM Structure” dialog opens (see Fig. A-5).

2. Select the ATM SDU to be transmitted and received in the test channel:
   – Testcell: Test cells to O.191
   – AAL-0: PRBS or DW in cell payload
   – AAL-1: PRBS or DW as AAL-1 PDU

3. Select the “Performance Measurement” to be used:
   – Cell Transfer Delay Results shown in ATM Traffic Analyzer, and
   – Error Related Performance Results shown in Anomaly and Defect Analyzer

4. Confirm your settings by clicking on the “OK” button.
   The “ATM Structure” dialog will be closed.

Setting the VPI/VCI parameters

✓ The “ATM Signal Structure” window is activated.

1. Select “ATM Channel...” from the “Channel” menu.
   – or –
   Click on the corresponding icon in the toolbar.
   The “ATM Channel” dialog opens.
2. Enter the VPI/VCI parameters of the test connection for the generator and receiver.
3. Confirm your entries by clicking on the “OK” button.
4. The “ATM Channel” dialog will be closed.
   The desired ATM signal structure appears in the display area of the “ATM Signal Structure” VI.

Fig. A-7  ATM layer signal structure (“ATM Signal Structure” VI)

- Click on the “ON” icon in the “ATM Signal Structure” VI to activate ATM traffic and the selected test cells are transmitted. If this channel is not active, empty cells will be transmitted.
- The default setting of the ATM Generator is:
  - Traffic type: CBR (constant bit rate)
  - 100 % load
2 ATM bit error rate test (ATM-BERT)

Only BN 3035/90.70

2.1 Test setup and description

For ATM networks too the bit error test is a basic measurement method that makes it possible to test network paths quickly and simply or to check configurations of network elements. With the ANT-20, you measure the bit errors via a test cell channel. Apart from bit error measurements on the cell payload, parallel measurements for correctable and non-correctable header errors are also being performed. If this error measurement is performed on cells with an AAL-1 structure, the ANT-20 also simultaneously checks the cell sequence integrity so that cell losses can also be found.

Fig. A-8 Setup for the ATM bit error rate test

2.2 Switch configuration

⇒ Set up an unidirectional, permanent connection with a UBR (Unspecified Bit Rate) contract through the switch.

2.3 Application selection on the ANT-20

Required VIs:
- Signal Structure
- ATM Signal Structure
- Anomaly and Defect Insertion
- Anomaly and Defect Analyzer

⇒ Insert the VIs you want in the list of VIs used on the Application Manager.

Your Application Manager contains at least the following instruments (see Fig. A-9).

Fig. A-9 Minibar (Application Manager) after selection of the VIs
2.4 Measurement

Example 1

Determining the bit error rate in the ATM layer.

Settings

1. First of all, set the Signal Structure VI as described.
2. Open the ATM Signal Structure VI.
3. In the “Edit” menu select the item “ATM Structure...”
   – or –
   click the appropriate icon on the toolbar.
   This activates the “ATM Structure” window.
4. In the “ATM SDU” field press the button “AAL0” and confirm with “OK”.
5. Start the measurement by pressing function key F5
   – or –
   click the “green traffic light” icon button in the Application Manager.

Analysis

Using the Anomaly and Defect Analyzer VI, you can observe whether errors are occurring or not. In the example below, HUNC (Header error UNCorrectable) errors occur.

Fig. A-10  “Anomaly and Defect Analyzer” window
Example 2

Insertion of a HCOR at a repetition rate of 1E-6 with analysis of the DUT reaction.

Settings

Do not change the settings of the VIs Signal Structure and ATM Signal Structure. The VI Anomaly and Defect Insertion must be reset.

![Image](image.png)

**Fig. A-11** “Anomaly and Defect Insertion” window

1. In the “View” menu select the items “Anomalies” and “ATM” – or –
   click the appropriate icons on the toolbar.
2. Mark the item “HCOR” in the “ATM” field.
3. Select the item “continuous” in the “Insertion” field.
4. Set a “Rate” of 1E-6 in the selection field.
5. In the insertion menu, select the item “ON” – or –
   confirm by clicking the “ON” button on the toolbar.
6. Start the measurement by pressing function key F5 – or –
   click the “green traffic light” icon in the Application Manager.

Analysis

You can observe the effect of the inserted error in the window of the Anomaly and Defect Analyzer VI. There is a choice of three different windows to display the result.
Fig. A-12  Table display

Fig. A-13  Histogram display

Fig. A-14  Single-value display
3 ATM latency test for ATM switches

Only BN 3035/90.70

3.1 Test setup and description

If the above configuration is used, the more port modules that are included the loop, the greater the delay. Measurements are made on ATM switches to determine whether there is a constant increase in delay as the number of looped-in port modules are increased.

3.2 Switch configuration

1. Set up an unidirectional connection with a constant bit rate through the switch for the reason that you can set up a physical loop at the second port.
2. Check that the switch accepts the PCR of 14.98 Mbit/s (35523 cells per second).
3. Set the CBR contract, say, to a PCR of 15 Mbit/s.

3.3 Application selection on the ANT-20

Required VIs:
- Signal Structure
- ATM Signal Structure
- ATM Traffic Analyzer

⇒ Insert the VIs you want in the list of VIs used on the Application Manager.

Your Application Manager contains at least the following instruments (see Fig. A-16).

Fig. A-16 Minibar (Application Manager) after selection of the VIs
3.4 Measurement

Settings

Signal Structure VI

⇒ First of all, set the Signal Structure VI as described.

ATM Signal Structure VI

1. Open the ATM Signal Structure VI.
2. In the “Edit” menu select the item “ATM Structure...”
   – or –
   click the appropriate icon button on the toolbar.
   This activates the “ATM Structure” window.
3. In the “ATM SDU” field select the “Testcell” test channel structure. (“Tx => Rx”).
4. Activate the “Cell Transfer Delay” button in the “Performance Measurement” field.
5. In the “Channel” menu select “ATM Channel...”
   – or –
   click the appropriate icon button on the toolbar.
   The “ATM Channel” dialog box opens.

![Fig. A-17 “ATM Channel” dialog box of the “ATM Signal Structure” VI](image)

6. In the “Channel” dialog box enter your VPI/VCI parameters for the transmitter and receiver
   and confirm with “OK”.
7. Transfer the send-side (Tx) settings in the “ATM Signal Structure” window to the receive side
   (Rx), by clicking the “Tx=>Rx” button.
8. Using the slider, set a load of 10% or 14.98 MBit/s in the displayed signal structure.
9. Confirm your entries with “OK”.
   The selected ATM signal structure is now activated.
10. Click the “ON” button on the toolbar.
    – The test channel is now connected and test cells are being sent.
    – In the off-state, the transmitter outputs empty cells only.
**ATM Traffic Analyzer VI**

1. Open the ATM Traffic Analyzer VI.
2. In the “View” menu select “Cell Transfer Delay”
   
   or
   
   click the “CTD” icon button on the toolbar.
   
   The display changes to “Cell Transfer Delay”.
3. Set the measurement interval in the “Cell Transfer Delay Setup” dialog box:
4. Activate “Cell Transfer Delay...” in the “Settings” menu
   
   or
   
   click the “SET” icon button.

![Cell Transfer Delay Setup dialog box](image)

Fig. A-18  “Cell Transfer Delay Setup” dialog box

**Application Manager VI**

⇒ Start the measurement:

   Press function key F5
   
   or
   
   click the “green traffic light” icon button in the Application Manager.

**Explanation of the parameters “measurement interval”, “class width” etc.**

A measurement interval is always divided into 128 classes. This means that, say, a measurement interval of 1310 ms gives a time per class of 10 ms (1310 ms / 128 = 10.23 ms). The number of test cells whose delay lies within a class is summed and displayed as a bar. If you increase the class width, you automatically increase the measurement interval. As a result, you also automatically reduce the resolution of the histogram.

Use Offset to obtain the smallest possible classes when the delays are large. Offset allows you to shift your measurement range. But you have to estimate the expected range of your results. Offset selection is not automatic.
Analysis

The results are displayed in the form of a histogram on the “ATM Traffic Analyzer” VI. There is a bar for each class that contains at least one cell.

![Histogram](image)

Fig. A-19  Result display in the “ATM Traffic Analyzer” window

Cursor read-off

⇒ Click the “CSR” icon on the toolbar. The window shown below opens and displays the numerical value indicated by the cursor.

![Cursor Window](image)

Fig. A-20  “Cell Transfer Delay Cursor Position” display window on the ATM Traffic Analyzer

The cell delay variation (CDV) can be determined in the “Cell Transfer Delay” display mode. The peak-to-peak CDV can be derived from the histogram. The peak-to-peak CDV corresponds to the 2-point cell delay variation to ITU-T I.356. The following results are provided by the CDV evaluation mode:

- the minimum cell delay
- the maximum cell delay
- the mean cell delay
- the 2-point cell delay variation (2-point CDV)
Fig. A-21 “Cell Delay Results” display window on the ATM Traffic Analyzers and definition of the peak-to-peak CDV
4 ATM latency test with background load
(ATM background generator)

Only BN 3035/90.70

4.1 Test setup and description

This test is performed to determine the extent to which the cell transit time through an ATM switch goes up when the switch loading is increased by connection requests. The result from the “ATM Latency Test for ATM switch” measurement is used as the reference. To perform this measurement, you must first set up the switch configuration as shown above.

Fig. A-22 Setup for the ATM latency test (ATM switch) with background load

4.2 Switch configuration

1. As shown above, set up unidirectional virtual ATM channels.
2. Check that the switch accepts the PCR of 149.76 Mbit/s (353209 cells per second), e.g. CBR contract: PCR = 15 Mbit/s.
4.3 Application selection on the ANT-20

Required VIs:

- Signal Structure
- ATM Signal Structure
- ATM Traffic Analyzer
- ATM Background Generator

⇒ Insert the VIs you want in the list of VIs used on the Application Manager.

Your Application Manager contains at least the following instruments (see Fig. A-23).

![Fig. A-23 Minibar (Application Manager) after selection of the VIs](image)

4.4 Measurement

Example

Load test on an ATM switch

Settings

“Signal Structure” and “ATM Signal Structure” VIs

Do not change the settings of these two VIs.

“ATM Background Generator” VI

The ATM Background Generator is an independent cell generator which you can use to define your own background traffic. The ATM traffic comprises one or more cell sequences.

1. Activate the “Background Generator” VI on the Application Manager.
2. Click the “New” icon button in the “Sequence Control” field.
   The “Sequence Editor-´NONAME´” window opens:
   At this stage, you can enter settings for a sequence. You can influence the contents of the header field of the ATM cells by doing so. Note that there are reserved values for VCI/VPI.
3. Enter the following parameters in the “Sequence” field:
   - Number of cell repetitions
   - Number of subsequent empty cells per sequence
   - Number of sequence repetitions
4. Confirm your entries with “OK”.
   You will now be asked to assign a name to the sequence (e.g. “test1”).
   The name is displayed in the “Cell Sequence” list in the main window.
Generating further sequences

For this measurement, you require a total of 9 sequences with different VCI/VPI values. In this way, you create 9 different virtual channels.

1. Click the “New” button.
2. Repeat the sequence generation procedure 1 to 4 on the previous page (see “Sequence Editor”).

Defining and activating background traffic

Define the background traffic by inserting the generated sequences in the “Cell Sequence” list into the “Transmit List” (see Fig. A-25).

1. Mark the first sequence to be inserted (e.g. “sequ_1”).
2. Click the “Add >>” button.
   The sequence is added to the Transmit List.
3. Insert the other sequences by repeating 1 and 2.
4. Activate the background traffic by clicking the “ON” button on the toolbar.

You will then be asked to store the settings. In response enter a name (e.g. “traffic1”).
Start measurement ("Application Manager" VI)

⇒ Press function key F5
   — or —
   click the “green traffic light” icon.

![Fig. A-25 “ATM Background Generator” window](image)

**Analysis**

⇒ Activate the window of the "ATM Traffic Analyzer" VI.

The measurement results are analyzed in the same way as the results of the previous reference measurement (ATM latency test for ATM switches).

Select the item “Export...” in the “Print” menu to store the measurement results in CSV format for further processing with EXCEL.
5 Sensor test - loss of cell delineation (LCD)

Only BN 3035/90.70

5.1 Test setup and description

The purpose of this test is to demonstrate that the alarm and error sensors in an ATM switch are operating properly (to ITU-T or ATM Forum). If there is an LCD alarm, the system has lost cell stream synchronization. The synchronization and the monitoring of the cell stream is performed by a state automat which is specified in ITU-T Recommendation I.432.

When a simple LCD alarm is inserted, the ANT-20 sends 7 consecutive cells with header errors. In this case, the ATM switch should output an LCD alarm for the port. The insertion time can be limited to 6 cells with header errors. In this case, the switch should synchronize.

5.2 Switch configuration

1. Set up a unidirectional, permanent connection with constant bit rate through the switch.
2. Check that the PCR (Peak Cell Rate) is 10 % of the channel capacity (in cells per second).
5.3 Application selection on the ANT-20

Required VIs:
- Signal Structure
- ATM Signal Structure
- Anomaly and Defect Insertion
- Anomaly and Defect Analyzer

⇒ Insert the VIs you want into the list of VIs used on the Application Manager.
Your Application Manager contains at least the following instruments (see Fig. A-27).

5.4 Measurement

Settings

“ATM Signal Structure” VI
1. Open the “ATM Signal Structure” window.
2. In the “Edit” menu, select the item “ATM Structure...”
   – or –
   click the appropriate icon on the toolbar.
   This activates the “ATM Structure” window.
3. In the “ATM SDU” field, click the “Testcell” button.
4. In the “Performance Measurement” field, click “Error-Related Performance”.
5. Transfer the send-side settings to the receive side by clicking the “Tx => Rx” button.
6. Confirm your entries with “OK”.
7. Set a load of 10% in the display window (“CBR” icon).

Fig. A-28 “ATM Structure” dialog box in the “ATM Signal Structure” window
“Anomaly and Defect Insertion” VI

1. Open the “Anomaly and Defect Insertion” window.
2. Click the “ATM” icon on the toolbar.
3. Click the “Defects” icon on the toolbar.
4. In the “ATM” field, select the item “LCD”.
5. In the “Insertion” field, select the item “single”.
6. Check that there is a “7” in the “Duration” field.

Start measurement (“Application Manager” VI)

⇒ Press function key F5
   or
   click the “green traffic light” icon.

Fig. A-29  “Anomaly/Defect Insertion” window
Analysis: “Anomaly/Defect Analyzer” VI

The ATM switch should output an LCD alarm, send a VP-RDI alarm and a VC-RD alarm in the opposite direction and resynchronize.

1. Open the window of the “Anomaly and Defect Analyzer” VI. The “VP-RDI” and the “VC-RD” alarms are clearly visible in the histogram display mode (see Fig. A-30).
2. Open the “Anomaly and Defect Insertion” window and change the number “7” in the “Duration” field to a “6”.
3. Restart the measurement.

If the switch is functioning properly, there should be no LCD alarm this time. The ATM switch remains synchronized.

Fig. A-30 “Anomaly/Defect Analyzer” window
6 Measuring the CLR with a variable cell rate (VBR traffic)

Only BN 3035/90.70

6.1 Test setup and description

![Diagram of test setup](image)

Fig. A-31 Setup for cell loss ratio measurements

The Cell Loss Ratio (CLR) is a quality of service parameter. The CLR is the ratio of the number of lost cells to the total cells sent.

6.2 Switch configuration

1. Set up a unidirectional, permanent connection with a variable bit rate through the switch.
2. Configure the VBR contract for the connection.

6.3 Application selection on the ANT-20

Required VIs:

- Signal Structure
- ATM Signal Structure
- ATM Traffic Analyzer
- Anomaly and Defect Analyzer

⇒ Insert the VIs you want in the list of VIs used on the Application Manager.

Your Application Manager contains at least the following instruments (see Fig. A-32).

![Screenshot of Application Manager](image)

Fig. A-32 Minibar (Application Manager) after selection of the VIs
6.4 Measurement

Settings

1. Open the “ATM Signal Structure” window.
2. In the “Edit” menu, select the item “ATM Structure...”
   – or –
   click the appropriate icon on the toolbar.
   This activates the “ATM Structure” window.
3. In the “ATM SDU” field, click the “Testcell” button.
4. In the “Performance Measurement” field, click “Error-Related Performance”.
5. Transfer the send-side settings to the receive side by clicking the “Tx => Rx” button.
6. Confirm your entries with “OK”.
7. In the “Traffic” menu, select the item “VBR”.
8. In the “Traffic” menu, select the item “Set VBR...”.
   The “VBR” dialog box opens.

9. Set the following parameters in the “Settings” field:
   – the Peak Cell Rate (PCR),
   – the Mean Cell Rate (MCR),
   – the burst length and
   – the burst period.
10. Confirm your entries with “OK”.

The mean cell rate that has been set is reflected in the ATM Signal Structure display.

Starting the measurement (“Application Manager” VI)

⇒ Press the function key F5
   – or –
   click the “green traffic light” icon.

Overview of the parameters: PCR, MCR, burst length, etc.

You can use the following parameters to define the variable load on the test channel:

- the Peak Cell Rate (PCR),
- the Mean Cell Rate (MCR),
- the burst length and
- the burst period.
The next Figure clarifies the significance of the various parameters: All parameters are related.

⇒ First of all, set the **Peak Cell Rate**.
   This cell rate equals the burst load.

The **Mean Cell Rate** is, therefore, directly dependent on the ratio of the burst length to the burst period. If you want a mean cell rate which is 50% of the peak cell rate, the burst period must be two times the burst length.

![Diagram of burst period and burst length](image)

**Fig. A-34** Definition of the burst period, burst length etc.

**Analysis**

1. Open the “Anomaly and Defect Analyzer” window.
2. In the “View” menu, select the item “Table”
   – or –
   click the appropriate icon on the toolbar.
   The measurement results are displayed as a table.
   If there are cell losses, you will find the precise CLR in this table.
Specifications

These specifications include the option BN 3035/90.70 (ATM Functions).
The ATM Mappings specifications are included in the operating manual BN 3035/98.15.

1 ATM generator

1.1 Scrambling

Scrambling is as per ITU-T recommendation I.432 (X43+1).
The function can be disabled.

1.2 Error insertion (anomalies)

The following anomalies can be inserted in addition to the error types described in the Mainframe “Specifications”.

<table>
<thead>
<tr>
<th>Error type: Anomaly</th>
<th>Single</th>
<th>Rate</th>
<th>Sensor thresholds</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEC uncor. 2</td>
<td>yes</td>
<td>1E-2 to 1E-6</td>
<td>M = 1 to 31 N = M + 1 to M + 31</td>
</tr>
<tr>
<td>HEC cor. 3</td>
<td>yes</td>
<td>1E-2 to 1E-6</td>
<td>M = 1 to 31 N = M + 1 to M + 31</td>
</tr>
<tr>
<td>AAL-1 Cell loss</td>
<td>yes</td>
<td>1E-3 to 1E-6</td>
<td>-</td>
</tr>
<tr>
<td>AAL-1 CRC</td>
<td>yes</td>
<td>1E-3 to 1E-6</td>
<td>-</td>
</tr>
<tr>
<td>AAL-1 PE</td>
<td>yes</td>
<td>1E-3 to 1E-6</td>
<td>-</td>
</tr>
</tbody>
</table>

1 Mantissa: 1 only, exponent: -1 to -6 (integer values)
2 Non-correctable header errors
3 Correctable header errors

Table S-1 Error types (anomalies) available in addition to the Mainframe

AAL-1 Cell loss, AAL-1 CRC and AAL-1 PE errors refer to the test channel (foreground channel). Test sequence errors (TSE) are inserted in the ATM payload or in the AAL-1 payload of the test channel. Correctable and non-correctable header errors will be inserted in the overall cell stream.
### 1.3 Alarm generation (defects)

The following defects can be generated in addition to the alarm types described in the Mainframe “Specifications”.

<table>
<thead>
<tr>
<th>Defect</th>
<th>Sensor function test</th>
<th>Single</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD(^1)</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>VC-AIS(^2)</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>VC-RDI(^3)</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>VP-AIS</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>VP-RDI</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Vx-AIS(^4)</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Vx-RDI(^4)</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

1. LCD (Loss of Cell Delineation) is generated by a non-correctable header error in ≥ 7 consecutive cells.
2. AIS: Alarm Indication Signal; VC: Virtual Channel; VP: Virtual Path
3. RDI: Remote Defect Indication
4. For Vx-AIS and Vx-RDI the alarms are inserted simultaneously in VP and VC.

Table S-2 Alarm types (defects) available in addition to the Mainframe
1.4 Test channel

**Cells**

**Header**
- UNI/NNI, VCI, VPI, PT and CLP... user-settable
- HEC... formed automatically

**Payload**
- Pseudo random sequences... PRBS 11, PRBS 15, PRBS 20, PRBS 23
- Digital word... 16 bits

**Load profile**
Constant, Equidistant, Burst

**Constant**
- Load setting... 0.01% to 100%
- Resolution for load range settings
  - from 0.01% to 0.99%... 0.01%
  - from 0.1% to 9.9%... 0.1%
  - from 1% to 100%... 1%

**Equidistant**
- Setting range
- Cell spacing... 1 to 10000 cell periods
- Resolution for cell spacing range settings
  - from 1 to 100... 1 cell period
  - from 10 to 1000... 10 cell periods
  - from 100 to 10000... 100 cell periods

**Burst**
- Setting range
- Maximum burst length... 1023 cells / 2.79 ms
- Burst load... 0 to 100%
- Resolution... depends on burst length
- Maximum burst period... 32767 cells / 89 ms
- Load units... Mbit/s, Cells/s, %
- Time units... µs, cell periods
1.5 Background load

The background load is generated from memory-based sequences. Foreground traffic (test channel) has priority.

- Header: freely settable
- Payload: byte-wise constant, byte freely settable
- Maximum load cell repeat factor (n1): 255
- Maximum number of empty cell following a load cell (n2): 1023
- Maximum sequence repeat factor (n1 load cells, n2 empty cells): 255
- Maximum number of sequences: 200

1.6 Fill cells

The cell stream is filled using IDLE or UNASSIGNED cells. The type of cell used can be switched.

1.7 AAL-1 segmentation

Unframed signals with system bandwidths of 1.5 Mbit/s, 2 Mbit/s, etc., can be transmitted in the AAL-1 PDU in the test channel.

Possible payload patterns at 2 Mbit/s: PRBS unframed, PRBS in PCM30, PRBS in PCM30CRC
2 ATM receiver

2.1 Descrambling

Descrambling is as per ITU-T recommendation I.432 (X43 +1).
The function can be disabled.

2.2 Measurement modes

2.2.1 Error measurement (anomalies)

The following anomalies can be evaluated and displayed in addition to those described in the Mainframe “Specifications”, section 2.3.3.

<table>
<thead>
<tr>
<th>Anomaly</th>
<th>LED</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>HCOR</td>
<td>-</td>
<td>Correctable Header Error</td>
</tr>
<tr>
<td>HUNC</td>
<td>-</td>
<td>Uncorrectable Header Error</td>
</tr>
<tr>
<td>CER</td>
<td>-</td>
<td>Cell Error Ratio</td>
</tr>
<tr>
<td>CLR</td>
<td>-</td>
<td>Cell Loss Ratio</td>
</tr>
<tr>
<td>CMR</td>
<td>-</td>
<td>Cell Misinsertion Rate</td>
</tr>
<tr>
<td>AAL-1-CRC</td>
<td>-</td>
<td>AAL1 CRC Error</td>
</tr>
<tr>
<td>AAL-1-PE</td>
<td>-</td>
<td>AAL1 Parity Error</td>
</tr>
<tr>
<td>AAL-1-CLR</td>
<td>-</td>
<td>AAL1 Cell Loss Ratio</td>
</tr>
<tr>
<td>AAL-1-CMR</td>
<td>-</td>
<td>AAL1 Cell Misinsertion Rate</td>
</tr>
</tbody>
</table>

Table S-3 Display and evaluation of anomalies

HUNC, HCOR errors refer to the overall cell stream, all other errors refer to the test channel.
2.2.2 Alarm detection (defects)

The following defects can be evaluated and displayed in addition to the alarm types described in the Mainframe “Specifications”, section 2.3.1.

<table>
<thead>
<tr>
<th>Defect</th>
<th>LED</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD</td>
<td>LOF / LCD</td>
<td>Loss of Frame/Loss of Cell Delineation</td>
</tr>
<tr>
<td>OCLR</td>
<td>-</td>
<td>Cell Loss Overflow(^1)</td>
</tr>
<tr>
<td>OCMR</td>
<td>-</td>
<td>Cell Misinserted Overflow(^2)</td>
</tr>
<tr>
<td>VC-AIS</td>
<td>-</td>
<td>Virtual Channel Alarm Indication Signal</td>
</tr>
<tr>
<td>VC-RDI</td>
<td>-</td>
<td>Virtual Channel Remote Defect Indication</td>
</tr>
<tr>
<td>VP-AIS</td>
<td>-</td>
<td>Virtual Path Alarm Indication Signal</td>
</tr>
<tr>
<td>VP-RDI</td>
<td>-</td>
<td>Virtual Path Remote Defect Indication</td>
</tr>
<tr>
<td>AAL-1-OOS</td>
<td>-</td>
<td>AAL1 Out of Sync</td>
</tr>
</tbody>
</table>

1 more than 255 lost cells within 100 ms or relative to last test cell  
2 more than 255 misinserted cells within 100 ms or relative to last test cell

Table S-4   LED displays indicating additional alarms

2.2.3 ATM performance measurements

Error Related Performance Parameters

The measurement is made using the test cells.

Results

Lost Cell Count, Cell Loss Ratio ..................................................... CLR  
Misinserted Cell Count, Cell Misinserted Rate ..................................... CMR  
Error Cell Count, Cell Error Ratio .................................................... CER

Cell Transfer Delay

The measurement “Cell Transfer Delay” is made using the test cells.

Display ................................................................. rate distribution  
Resolution ............................................................ 160 µs to 0.355 s  
Range ................................................................. 20 µs to 42.9 s  
Range offset .....................................................0 to 0.167 s  
Units ................................................................. µs  

Cells with delay times outside the measurement range will be assigned to class 0 (underflow) or class 127 (overflow).
Cell Delay Variation

The measurement “Cell Delay Variation” is made using the test cells.

Display ............... rate distribution, minimum cell delay, maximum cell delay, mean cell delay, 2-Point-CDV, (Peak-to-peak-CDV)

Results are valid only if no delay times outside the measurement range are detected.

2.2.4 Payload channel analysis and load measurement

Cell filters (VCI, VPI) for extracting the test channel.

The VCI filter can be disabled.

Average cell rate

The measurement is made over all connections and in the test channel simultaneously.

Measurement interval ................................................................. 1 s
Resolution ................................................................. 0.01 %

Load indicator

Units ................................................................. Mbit/s, Cells/s, %
Scaling ................................................................. linear, logarithmic

Peak cell rate

The measurement is made in the test channel.

Measurement interval ................................................................. 1 s
Resolution ................................................................. 0.1 %

Load indicator

Units ................................................................. Mbit/s, Cells/s, %
Scaling ................................................................. linear, logarithmic
Channel loading histogram

Measurement interval .............................................. 100 ms
Number of classes ................................................. 101
Class “0” contains the number of 100 ms intervals in which a load of 0 % is measured.
Class width .......................................................... 1
Load indicator ......................................................... Mbit/s, Cells/s, %

Payload channel cell distribution

Display of payload channel cells classified into payload cells, OAM cells and payload cells with
CLP marked

Measurement interval .............................................. 1 s
Display ................................................................. cell count

Test cell format

<table>
<thead>
<tr>
<th>Scrambled part</th>
<th>x² + x⁵ + 1</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Sequence number</th>
<th>Time stamp</th>
<th>0</th>
<th>0</th>
<th>CRC 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 bytes</td>
<td>4 bytes</td>
<td>38 bytes</td>
<td>1 byte</td>
<td>2 bytes</td>
</tr>
</tbody>
</table>

Test cell payload

Fig. S-1 Test cell format as per ITU-T O.191 (Draft 4/95)
2.2.5 **AAL-1 Reassembly**

Reassembly of AAL-1 structured cells is from the SAR-PDU. The format is shown in Fig. S-2, Page I-9. The “TSE” error measurement is made using framed or unframed PRBS mapped into the SAR-PDU payload.

The following payload patterns are available for error measurements:

- PRBS unframed
- PRBS in PCM30 frame
- PRBS in PCM30 frame (with CRC)

![SAR-PDU format for AAL-1 cells](image)

---

**SN**: Sequence Number  
**SNP**: Sequence Number Protection  
**PDU**: Protocol Data Unit  
**SAR**: Segmentation and Reassembly  
**47 bytes**:  

---

Fig. S-2  
SAR-PDU format for AAL-1 cells
Notes: